**1 Description**

This reference design implements single-phase inverter (DC/AC) control using a C2000™ microcontroller (MCU). The design supports two modes of operation for the inverter: a voltage source mode using an output LC filter, and a grid connected mode with an output LCL filter. High-efficiency, low THD, and intuitive software make this design attractive for engineers working on an inverter design for UPS and alternative energy applications such as PV inverters, grid storage, and micro grids. The hardware and software available with this reference design accelerate time to market.

**2 Resources**

- TIDM-HV-1PH-DCAC Design Folder
- TIEVM-HV-1PH-DCAC Orderable EVM Tool
- TMS320F28377D Product Folder
- TMS320F280049M Product Folder
- AMC1304 Product Folder
- OPA4350 Product Folder
- UC3865 Product Folder
- C2000Ware DigitalPower SDK Tool Folder

**3 Features**

- 380-DC V_in, 110 V_{rms}, 60 Hz or 22 V_{rms}
- 50-Hz Output Selectable, 600-VA Max Output
- 98% Peak Efficiency
- 20-kHz Switching
- Low Total Harmonic Distortion (THD)
  - < 1% for Linear Loads and < 3% for Typical Non-Linear Loads With SDFM
  - < 2% for Linear Loads and < 4% for Typical Non-Linear Loads With ADC
- powerSUITE™ Support for Easy Adaption of Design
- Software Frequency Response Analyzer (SFRA) and Compensation Designer for Ease of Turning of Control Loops and Robustness of Design
- Selectable Operation of Controller on Cold or Hot (Isolated or Non-Isolated Side)
- Supports TMS320F28377D and TMS320F280049M

**4 Applications**

- Uninterrupted Power Supply (UPS)
- Micro Grids
- Photovoltaic Inverters
- Grid Storage
- Active Rectifier
5 System Description

Voltage source inverters (VSIs) are commonly used in uninterruptible power supplies (UPS) to generate a regulated AC voltage at the output. Control design of such inverter is challenging because of the unknown nature of load that can be connected to the output of the inverter.

This reference design uses devices from the C2000 microcontroller (MCU) family to implement control of a voltage source inverter. An LC output filter is used to filter the switching component in this high-frequency inverter. The firmware of the design is supported in powerSUITE framework, which enables easy adaptation of the software and control design for a custom voltage source inverter.

This reference design features high efficiency, low THD, and intuitive software, which makes it fast and easy to design VSIs. VSIs are increasingly being used in new alternative energy applications such as photovoltaic inverters, micro grids, grid storage, and more.
5.1 Key System Specifications

Table 1 shows the key system specifications of this reference design.

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage ($V_{IN}$)</td>
<td>Typical 380-V DC absolute max 400-V DC</td>
</tr>
<tr>
<td>Input current ($I_{IN}$)</td>
<td>1.7 A max</td>
</tr>
<tr>
<td>Output voltage ($V_{OUT}$)</td>
<td>Typical 110 $V_{RMS}$ or 220 $V_{RMS}$</td>
</tr>
<tr>
<td></td>
<td>Absolute max 400 V</td>
</tr>
<tr>
<td>Output current ($I_{OUT}$)</td>
<td>Absolute RMS max 5 A</td>
</tr>
<tr>
<td></td>
<td>Pulse max 10 A</td>
</tr>
<tr>
<td>VA rating</td>
<td>Absolute max 600 VA</td>
</tr>
<tr>
<td>THDv: Voltage total harmonic distortion</td>
<td>Linear loads:</td>
</tr>
<tr>
<td></td>
<td>$&lt; 1%$ when using SDFM-based sensing</td>
</tr>
<tr>
<td></td>
<td>$&lt; 2%$ when using ADC-based sensing</td>
</tr>
<tr>
<td></td>
<td>Typical non-linear loads:</td>
</tr>
<tr>
<td></td>
<td>$&lt; 3%$ when using SDFM-based sensing</td>
</tr>
<tr>
<td></td>
<td>$&lt; 4%$ when using ADC-based sensing</td>
</tr>
<tr>
<td>Efficiency</td>
<td>3 mH</td>
</tr>
<tr>
<td></td>
<td>20 µF</td>
</tr>
<tr>
<td></td>
<td>20 kHz</td>
</tr>
</tbody>
</table>

Efficiency

- At 220 $V_{RMS}$:
  - Peak 98%, average is approximately 97%

- At 110 $V_{RMS}$:
  - Peak 96.8%, average is approximately 96%
6 System Overview

6.1 Block Diagram

A typical inverter comprises of a full bridge that is constructed with four switches, which can be modulated using pulse width modulation (PWM), and a filter for the high-frequency switching of the bridge, as shown in Figure 1. An inductor capacitor (LC) output filter is used on this reference design.

![Figure 1. Typical Single Phase Inverter](image)

6.2 System Design Theory

To regulate the output voltage of the inverter, current and voltages must be sensed. The fast and precise on-chip analog-to-digital converters (ADCs) on the C2000 MCU are excellent to sense these signals. Sigma delta-based sensing can provide easy isolation and superior sensing of these signals. Many C2000 MCUs have sigma-delta demodulators built in to decode signals from sigma delta modulators, making their use in an application straightforward.

Once the signals are sensed, the C2000 MCU runs the control algorithm to compute the modulation required for regulated operation. The compensation designer implements the model of the power stage, which makes design of digital control loop coefficients easy. SFRA enables measurement of the frequency response in-circuit to verify the accuracy of the model and ensure robustness of the control.

6.2.1 Modulation Scheme

Popular modulation schemes for the PWM generation include bipolar modulation and unipolar modulation. On this design, a modified unipolar modulation is chosen in which switches Q1 and Q2 are switched at a high frequency and switch Q3 and Q4 are switched at a low frequency (frequency of the AC waveform synthesized). Table 2 lists the switching states used on this reference design. The flexible PWM peripheral of the C2000 MCU enables the generation of these signals easily. Figure 2 shows how the PWM peripheral is configured for the modulation on this reference design. Ensure that the PWM waveform is symmetric around the zero crossing of the AC wave.

![Table 2. Switching States Used in TIDM-HV-1PH-DCAC](image)
6.2.2 Voltage and Current Sensing

To control the inverter stage for desired operation, voltage and current need to be sensed for processing by the digital controller. The design implements sensing scheme based on ADCs and sigma delta filter modules (SDFMs). An Excel® sheet is also provided in the install package to understand the sensing methodology. The Excel sheet is located at `sdk_install_path_<version>/solutions/tidm_hv_1ph_dcac/hardware/baseboard/calculation.xlsx`.

This reference design is supported in powerSUITE framework, which enables entering values of the components in the sensing circuitry resistor dividers (and so on) on the powerSUITE configuration (CFG) page of the solution. This page calculates the maximum sense value, which determines the feedback gain of the control system and is used for the compensation design and tuning.

6.2.2.1 ADC-Based Sensing

On this reference design, the following signals are sensed using the on chip ADC resource. The values shown here can also be entered through the powerSUITE CFG page when ADC-based sensing is selected for the inverter.
6.2.2.1.1 DC Bus Sensing

The high-voltage DC bus is scaled down using a resistor divider. This resistor divider output can be
directly fed into the ADC. Figure 3 shows how the op amp stage is used to buffer.

\[ V_{bus_{- fedb}} = \frac{2R_b}{(R_a + R_b)} V_{bus} \]

Figure 3. DC Bus Sensing Using Resistor Divider and Op Amp

6.2.2.1.2 AC Output Voltage Sensing

The AC output voltage is sensed differentially using resistor dividers and op amps, as shown in Figure 4.
An offset voltage is added to the signal to enable measurement using the ADC, which can only convert
positive voltages.

\[ V_{out_{- fedb}} = \frac{R_d}{R_c} (V_+ - V_-) + 1.65 \]

Figure 4. AC Output Voltage Differential Sensing Using Resistor Divider and Op Amp

6.2.2.1.3 Inductor Current Sensing

A Hall effect sensor is used to sense the current through the inductor. The Hall effect sensor has a built-in
offset, and the range is different than what ADC can measure. The voltage is scaled to match the ADC
range using the circuit shown in Figure 5.

\[ I_{inv_{- fedb}} = \frac{R_f}{R_e} \left( I_{inv} \times \frac{V_{nominal}}{I_{nominal_{- max}}} + V_{offset} \right) \]

Figure 5. Current Sense Using the Hall Effect Sensor
6.2.2.1.4 **Sense Filter**

An RC filter is used to filter the signals before being connected to the inverter. Figure 6 shows a common RC filter used for all the sensing signals on this design.

\[
\text{Output} = \frac{1}{1 + \frac{1}{R_{\text{ftr}} C_{\text{ftr}}} s}
\]

**Figure 6. RC Filter**

6.2.2.1.5 **Protection (Windowed Comparators)**

Most power electronics converters need protection from an overcurrent event. For this reason, multiple comparators are needed, and references for the current and voltage trip need to be generated (see Figure 7).

**Figure 7. Trip Generation for PWM Using Comparators and Reference Generators**

All of this circuitry is avoided when using C2000 MCUs such as the TMS320F28377D device, which has an on-chip windowed comparator that is internally connected to the PWM module that can enable fast tripping of the PWM. This comparator saves board space and cost in the end application as extra components can be avoided using on-chip resources, as shown in Figure 8.

**Figure 8. Comparator Subsystem Used for Overcurrent Protection**
6.2.2.2 SDFM-Based Sensing

In this reference design, the following signals are sensed using the SDFM demodulator. The AMC1304 is used to generate the sigma delta stream. The clock for the modulator is generated from the ECAP peripheral on the C2000 MCU. The AMC1304 modulator senses the signal in an isolated fashion and is very useful when designing inverters in which the controller needs to be on the isolated and cold side. The values shown in the following subsections can also be entered through the powerSUITE CFG page when SDFM-based sensing is selected for the inverter.

6.2.2.2.1 Isolated Output Current and Capacitor Current Sensing

A shunt resistor senses the capacitor current and the output current on this reference design. The voltage across the shunt resistor is fed into the AMC1304 sigma-delta modulator, which generates the sigma-delta stream that is decoded by the SDFM demodulator present on the C2000 MCU. The inductor current is deduced from the capacitor and the output current readings. Figure 9 shows the SDFM-based isolated current sensing using a shunt resistor.

$$I_{\text{inv}} = \frac{I_{\text{inv}_{\text{fbk}, \text{pu}}}}{V_{\text{sense, max}} / R_{\text{sh}}}$$

Figure 9. SDFM-Based Isolated Current Sensing Using a Shunt Resistor

6.2.2.2.2 Isolated Output Voltage and DC Bus Sensing

A resistor divide network senses the DC bus and output voltage using the SDFM modulators. The differential input resistance of the SDFM modulator must be accounted for when interpreting the demodulated signals. Figure 10 shows the SDFM-based isolated voltage sensing for DC bus and output voltage.

$$V_{\text{fbk}, \text{pu}} = \frac{V}{V_{\text{sense, max}} (R_{\text{h}} || R_{\text{diff}}) / (R_{\text{g}} + (R_{\text{h}} || R_{\text{diff}}))}$$

Figure 10. SDFM-Based Isolated Voltage Sensing for DC Bus and Output Voltage

6.2.2.3 Protection

In addition to the data filter, which can be used to demodulate the SDFM stream generated by the modulator with specified oversampling rate (OSR) and filter order (SINC1, SINC2, SINC3), the SDFM module has additional comparator filters that can be programmed with much lower OSR and filter order to enable fast trip of the PWM.

6.2.2.4 SDFM Clock Generation

The ECAP module generates the clock for the SDFM modulator AMC1304. This clock is routed outside from the ECAP module using the OutputXbar and then routed back in to the SDFM CLK pins on the device. For details on usage of SDFM and CLK pins on this reference design, see Table 3.
6.2.2.2.5 **SDFM Filter Reset Generation and Syncing to the Inverter PWM**

SDFM provides a continuous stream of data. This data is then demodulated by the C2000 SDFM peripheral. Most control applications require the sampling of the data to be centered deterministically around the switching waveform (that is, the controlling PWM). The C2000 MCU provides a mechanism to generate this sync signal to the SDFM demodulator. The exact mechanism of the sync can be different on different devices. The following sections detail the sync mechanism as provided on several the C2000 devices.

6.2.2.2.6 **TMS320F2837x/TMS320F2807x**

On these devices, the PWM11 is tied to the SDFM reset generation; hence, the sync generation involves propagation of the sync from the inverter PWM to the PWM11 module. As the SDFM data is only valid 3 OSR time periods after the sync is provided, determine the time to read the SDFM data. Figure 11 shows the SDFM filter reset being generated from the PWM module and the ISR trigger to read the SDFM registers.

![Figure 11. SDFM Filter Reset Being Generated From PWM Module and ISR Trigger to Read SDF Registers](image)

**Figure 11. SDFM Filter Reset Being Generated From PWM Module and ISR Trigger to Read SDF Registers**
6.2.3 Control Scheme

Figure 12 shows a cascaded control loop scheme, which controls the output voltage of the inverter. Input DC bus voltage $V_{bus}$, inductor current $i$, and output voltage $V_o$ are sensed by the MCU.

First, a reference sinusoidal value $invVoRefInst$ is generated. This value is compared with the sensed output voltage $invVoInst$ and the error fed into the voltage compensator $G_v$. In case of AC voltage control, the tracking error needs to be zeroed for the AC frequency; hence, a proportional resonant controller is used in $G_v$ to zero the fundamental voltage error.

NOTE: A proportional integral controller zeroes error at DC and is not able to eliminate steady state error when the reference is a sinusoidal signal.

Additional resonant controllers are added to the voltage compensator to zero the error at harmonic frequency of the fundamental frequency being generated. A lead lag compensator is also added to the voltage compensator to improve the phase margin in the reference design.

$$G_v = K_{pi_{-H}} + \sum_{n=1}^{N} K_{iV_{-nH}}\frac{s^2 + 2\omega rc_{-nH}S + \omega^2_{o_{-nH}}}{s^2 + 2\omega rc_{-nH}S + \omega^2_{o_{-nH}}}G_{Lead\_Lag}$$  (1)

Where $N$ is the total number of harmonic compensators added in the voltage control loop. A total of four compensators that compensate the first harmonic, third harmonic, fifth harmonic, and seventh harmonic are used in this reference design. The compensation designer models the voltage loop plant and enables tuning of the voltage loop compensator coefficients through the powerSUITE CFG page.
Figure 13 shows the control model used to model the voltage source inverter operation.

The design of the voltage loop is aided by an inner current loop. The voltage compensator generates a current reference \( i_{ii_{\text{RefInst}}} \) for the current loop in which a current compensator \( G_i \) is used. Both DC bus voltage and output voltage feedforward in the current loop make the plant simple, and the PI controller can be used to tune the current compensator. The plant model of the inverter current loop is available inside compensation designer, which can be invoked from the powerSUITE page.

6.2.4 Inductor Design

The primary role of the inductor (\( L_i \)) in the output filter is to filter out the switching frequency harmonics. The design of an inductor, amongst other factors, depends on the calculation of the current ripple and choosing a material for the core that can tolerate the calculated current ripple. Figure 14 shows one switching cycle waveform of the inverter output voltage \( V_i \) with regards to the inductor current.

The voltage across the inductor is given by Equation 2:

\[
V = L_i \times \frac{di}{dt}
\]  
(2)
For the full-bridge inverter with an AC output, write the equation as:

\[ (V_{\text{Bus}} - V_O) = L_i \times \frac{\Delta I_{pp}}{D \times T_s} \]  

(3)

Where \( T_s = \frac{1}{F_{sw}} \) is the switching period. Now, rearrange the current ripple at any instant in the AC waveform, given as:

\[ \Delta I_{pp} = \frac{D \times T_s \times (V_{\text{Bus}} - V_O)}{L_i} \]  

(4)

Assuming the modulation index to be \( m_a \), the duty cycle is given as:

\[ D(\omega t) = m_a \times \sin(\omega t) \]  

(5)

The output of the inverter must match the AC voltage as it is safe to assume:

\[ V_O = V_{\text{DC}} \times D \]  

(6)

Therefore,

\[ \Delta I_{pp} = \frac{V_{\text{Bus}} \times T_s \times m_a \times \sin(\omega t) \times (1 - m_a \sin(\omega t))}{L_i} \]  

(7)

As seen in Equation 7, the peak ripple is a factor of where the inverter is in the sinusoidal waveform (for example, the modulation index). To find the modulation index where the maximum ripple is present, differentiate Equation 7 with regards to time to get Equation 8, and equate to zero.

\[ \frac{d(\Delta I_{pp})}{dt} = K(\cos(\omega t)(1 - m_a \sin(\omega t)) - m_a \sin(\omega t) \times \cos(\omega t)) = 0 \]  

(8)

then gives the modulation index for which the ripple is maximum, substituting back in Equation 7. The inductance value required to tolerate the ripple is shown in Equation 9 and Equation 10:

\[ \Delta I_{pp}^{\max} = \frac{V_{\text{Bus}} \times T_s}{4 \times L_i} \]  

(9)

\[ L_i = \frac{V_{\text{Bus}}}{4 \times F_{sw} \times \Delta I_{pp}^{\max}} \]  

(10)

For this design, the rating is 600 VA, the switching frequency is 20 kHz, and the bus voltage is 380 V. Assume that the ripple is 20% and is tolerable by the inductor core, and the minimum inductance required is calculated as:

\[ L = \frac{380}{4 \times 20000 \times 5.45 \times 1.414 \times 0.20} = 3.08 \text{ mH} \]  

(11)

These calculations are also provided inside an Excel sheet for convenience located at: location of Excel sheet to C:\\ti\\c2000\\C2000Ware_DigitalPower_SDK_\<version>\\solutions\\tidm_hv_1ph_dcac\\hardware\\baseboard\\calculation.xlsx sheet → UPS Li & Cf Sel

An appropriate core must be selected with these values in mind, and the inductor is designed to meet the inductance value.

6.2.5 Capacitance Selection

The output inductor and capacitor form a low pass filter that filters out the switching frequency. To get good switching frequency attenuation the cut off frequency is kept at \( F_{sw}/10 \) or lower.
7 Hardware, Firmware, Testing Requirements, and Test Results

7.1 Required Hardware and Firmware

7.1.1 Hardware

This section details the hardware and explains the different sections on the board. If one is using just the firmware of the design through powerSUITE, this section may not be valid.

NOTE: This reference design is also available for order as TIEVM-HV-1PH-DCAC. Note for the 15-V DC power supply, 15 W is not shipped with the design and must be arranged for by the user. A two-pronged power supply is recommended so it is truly floating and isolated. Cables, loads, oscilloscopes, and current probes must be arranged for by the user and connected to this EVM according to the user guide instructions and observing local compliance and standards for wiring. Use isolated power supplies.

7.1.1.1 Base Board Settings

This reference design follows an HSEC control card concept, and any device for which the HSEC control card is available from the C2000 MCU product family can be potentially used on the design. The key resources used for controlling the power stage on the MCU are listed in Table 3. Figure 15 shows the key power stage and connectors on the reference design, and Table 4 lists the key connectors and their functions. To get started:

1. Confirm that no power source is connected to the design.
2. Confirm that the output filter is correct for the mode that the device will run in. For example, voltage source inverter uses an LC filter. The L2 and L2N slot must be jumper wired as shown in Figure 11.
3. Ensure that the capacitor is 20 µF by checking the marking on the capacitor.
4. Insert the control card in the J15-J16 slot.
5. Insert a jumper at J10 if not already populated.
7. Insert a jumper at J4 if not already populated. The LED lights on the base board and control card will light up to indicate that the device is powered up.

NOTE: The bias for the MCU is separated from the power stage, enabling safe bring up of the system.

8. To connect JTAG, use a USB cable from the control card and connect it to a host computer.
9. A DC source can also be connected to the J17, but do not apply power at this point.
10. Connect a resistive load of approximately 100 Ω to the output from J1.
Table 3. Key Controller Peripherals Used for Control on the Full Bridge on the Board

<table>
<thead>
<tr>
<th>SIGNAL NAME</th>
<th>HSEC PIN NUMBER</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>PWM-1A</td>
<td>49</td>
<td>PWM: Inverter drive</td>
</tr>
<tr>
<td>PWM-1B</td>
<td>51</td>
<td>PWM: Inverter drive</td>
</tr>
<tr>
<td>PWM-2A</td>
<td>53</td>
<td>PWM: Inverter drive</td>
</tr>
<tr>
<td>PWM-2B</td>
<td>55</td>
<td>PWM: Inverter drive</td>
</tr>
<tr>
<td>i.inv</td>
<td>15</td>
<td>ADC: Inductor current measurement</td>
</tr>
<tr>
<td>1.65V</td>
<td>17</td>
<td>ADC: Reference voltage generated on the board</td>
</tr>
<tr>
<td>Bus.V</td>
<td>21</td>
<td>ADC: DC bus sensed on the board</td>
</tr>
<tr>
<td>Line.V</td>
<td>25</td>
<td>ADC: AC voltage sensing</td>
</tr>
<tr>
<td>PLC_RX</td>
<td>27, 12</td>
<td>ADC: PLC ADC pin</td>
</tr>
<tr>
<td>SD_Data_CapI</td>
<td>99</td>
<td>SDFM: Data from the SDFM modulator for the capacitor current feedback</td>
</tr>
<tr>
<td>SD_Data_GridI</td>
<td>103</td>
<td>SDFM: Data from the SDFM modulator for output current</td>
</tr>
<tr>
<td>SD_Data_Vbus</td>
<td>100</td>
<td>SDFM: Data from the SDFM modulator for the DC bus voltage</td>
</tr>
<tr>
<td>SD_Data_GridV</td>
<td>107</td>
<td>SDFM: Data from the SDFM modulator for the grid voltage</td>
</tr>
<tr>
<td>SD_CLK_GridV / SD_CLK_CapI</td>
<td>50, 101, 105, 109</td>
<td>SDFM: Data from the SDFM modulator for the grid voltage</td>
</tr>
<tr>
<td>SD_CLK_Vbus</td>
<td>102, 54</td>
<td>SDFM: Clock from the SDFM modulator used for Vbus measurement. The clock is generated from ECAP1 module which is brought out using the output xBar</td>
</tr>
<tr>
<td>OPRLY</td>
<td>52</td>
<td>GPIO: relay gpio output</td>
</tr>
<tr>
<td>SW-ON</td>
<td>56</td>
<td>GPIO: switch gpio input</td>
</tr>
</tbody>
</table>
Table 4. Key Connectors and Their Function

<table>
<thead>
<tr>
<th>CONNECTOR NAME</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>J17</td>
<td>Used to connect the high-voltage DC bus at the input</td>
</tr>
<tr>
<td>J2</td>
<td>Supplies the bias power supply for the control card and the circuitry for sensing on the base board</td>
</tr>
<tr>
<td>J4</td>
<td>Can be used to disconnect bias power</td>
</tr>
<tr>
<td>J1</td>
<td>AC connector to connect the output to load</td>
</tr>
<tr>
<td>J15-J16</td>
<td>HSEC control card slot</td>
</tr>
<tr>
<td>J10</td>
<td>Supplies the DC bias power supply to the isolated gate drivers, and the drivers must be populated</td>
</tr>
</tbody>
</table>

**Figure 16** shows a block diagram of a typical setup of this reference design under test.

**7.1.1.2 Control Card Settings**

Certain settings on the device control card are needed to communicate over JTAG; use the isolated UART port, and provide a correct ADC reference voltage. The following settings are required on revision 1.1 of the TMS320F28377D control card. Refer to the info sheet located inside C2000Ware at `<sdk_install_path>c2000Ware\boards\controlCARDs\TMDSCNCD28377D`.

1. Set A:SW1 on both ends of the control card to the **ON** (up) position to enable the JTAG connection to the device and UART connection for the SFRA GUI. If the switch is **OFF** (down), the user cannot use the isolated JTAG built in the control card, nor can the SFRA GUI communicate with the device.

2. Connect the USB cable to A:J1 to communicate to the device from a host PC on which Code Composer Studio™ (CCS) runs.

3. For the control loop, set the appropriate jumpers to provide a 3.3-V reference externally to the on-chip ADC.
Certain settings on the device control card are required to communicate over JTAG and use the isolated UART port. The user must also provide a correct ADC reference voltage. The following settings are required for revision A of the TMS320F280049M control card (refer to the info sheet located at <sdk_install_path>c2000ware\boards\controlcards\TMDSCNCD280049M>:

1. Set both ends of S1:A on the control card to ON (up) position to enable JTAG connection to the device and UART connection for SFRA GUI. If this switch is OFF (down), the user cannot use the isolated JTAG built in on the control card, nor can the SFRA GUI communicate with the device.
2. Connect the USB cable to J1:A to communicate with the device from a host PC on which CCS runs.
3. For the control loop, use the internal reference of the TMS320F28004x and move the S8 switch to the left (that is, pointing to VREFHI).
4. For the best performance of this reference design, remove the capacitor connected between the isolated grounds on the control card, C26:A.
5. GPIO24 through GPIO27 are muxed on the TMS320F280049M control card. To route them to the correct control card pins for the SDFM, put all the switches on SW5 to OFF (down) and all the switches on SW6 to ON (up).

7.1.1.3 **Tips to Connect JTAG USB Cable**

High-voltage boards can generate high EMI due to switching action. Even though the JTAG is isolated, some coupling can still occur due to radiated EMI. This coupling can result in a loss of JTAG frequently. To avoid this from happening, perform the following steps:

1. Wind the USB cable around a ferrite bead as shown in Figure 17.

---

Figure 17. USB Cable Around Ferrite Bead
2. Make sure the USB cable does not cross directly over the high-voltage section. This setup can be ensured on this design by the following connection of the USB cable.

![USB Connection on Board](image)

**Figure 18. USB Connection on Board**

### 7.1.2 Firmware: powerSUITE™ and Incremental Build Software

**NOTE:** The firmware for the solution is supported on both the TMS320F283779D and TMS320F280049M devices.

#### 7.1.2.1 Opening the Project Inside Code Composer Studio™

To start:

1. Install CCS (version 7.4 or above).
2. Open CCS.
3. Go to View → CCS App Center.
4. Under CCS Add-ons, make sure GUI Composer Runtime v1.0 is installed. If not, install the GUI Composer Runtime v1.0.
5. Install the C2000Ware DigitalPower SDK at the C2000Ware Digital Power SDK tool folder.

**NOTE:** powerSUITE is installed with the DigitalPower SDK in the default install.

6. Close CCS, and open a new workspace.
7. CCS automatically detects powerSUITE, and a restart of CCS may be required for the change to be effective.
8. Go to View → Resource Explorer

The software of this design can be opened in two modes.
7.1.2.1.1 Open TI Design Software as is

This mode opens firmware as it was run on this design or hardware, requires the board to be exactly the same as this reference design, and does not allow modification through the powerSUITE GUI inside the project.

2. The development kit and designs page appear. Use this page to browse all the information on the design including this user guide, test reports, and hardware design files.
3. Click on Run<device name>Project.
4. The project imports into the workspace environment. A .cfg page with a GUI similar to Figure 19 appears.

**NOTE:** As this project is imported from the development kit and reference design page, modifications to the power stage parameters through the GUI are not allowed.

5. If the GUI page does not appear, see the FAQ section under powerSUITE in the C2000Ware DigitalPower SDK resource explorer.

7.1.2.1.2 Open TI Design Software for Adaptation

The user can modify power stage parameters, which are then used to create the model of the power stage in compensation designer, and also modify scaling values for voltages and currents.

1. In the resource explorer under C2000Ware Digital Power SDK powerSUITE, click on the Solution Adapter Tool.
2. Select Inverter 1PH from the list of solutions presented.
3. Select Voltage Source Inverter.
4. Select the device the solution needs to run on.
5. Once the icon is clicked, a pop-up window appears asking for a location to create the project. The user can also save the project inside the workspace itself.
6. Once the location is specified, a project is created, and a GUI page appears with modifiable options for the solution, as seen in Figure 19.
7. Use the GUI to change the parameters for an adopted solution, such as power rating, inductance, capacitance, or sensing circuit parameters if desired.
8. If the GUI page does not appear, see the FAQ section under powerSUITE in the C2000Ware DigitalPower SDK resource explorer.
Figure 19. powerSUITE Page for Voltage Source Inverter Solution
### Project Structure

Once the project is imported, the project explorer appears inside CCS, as shown in Figure 20.

**NOTE:** Figure 20 shows the project for TMS320F2837x; however, if a different device is chosen from the powerSUITE page, the structure will be similar.

Solution-specific and device independent files are `voltagesourceinvlcfltr.c/h`. This file consists of the main.c file of the project and is responsible for the control structure of the solution.

Board specific and device specific files are `hv1phdcac_board.c/h`. This file consists of device specific drivers to run the single phase inverter. If the user desired to use a different modulation scheme or use a different device changes are required only to these files, aside from changing the device support files in the project.

The powerSUITE page can be opened by clicking on the `main.cfg` file, listed under the project explorer. The powerSUITE page generates the `voltagesourceinvlcfltr_settings.h` file. This file is the only file used in the compile of the project that is generated by the powerSUITE page. Modify the code placed under the 'User-Section' in this file. powerSUITE overwrites changes made outside of this section.

The `Kit.xml` and `solution.js` files are used internally by powerSUITE and must also not be modified by the user. Any changes to these files result in project not functioning properly. Figure 20 shows the project explorer view of the solution project.

The project consists of an interrupt service routine, which is called every PWM cycle called `inverter_ISR()` where the control algorithm is executed. In addition to this, there are background tasks A0-A4, B0-B4, C0-C4, which are called in a polling fashion and can be used to run slow tasks for which absolute timing accuracy is not required.
7.1.2.3 Running the Project

The software of this reference design is organized in three incremental builds and a few options to test the control loop design. The incremental build process simplifies the system bring-up and design. This process is outlined in the following sections. If using the reference design hardware, make sure the hardware setup is completed as outlined in Section 7.1.1.

7.1.2.3.1 Build Level 1—Open Loop

In this build, the inverter is excited in open loop fashion with a fixed modulation index, as shown in Figure 21. First, a ramp generator generates the theta angle, which is then used to compute the sine value. This sine value is multiplied with the `invModIndex` variable, which gives the duty cycle `invDutyPU` with which the inverter full bridge is modulated. Modulation scheme and feedback values from the power stage can be checked in this build to ensure they are correct and there are no hardware issues.

Figure 21. Build Level 1 Control Diagram: Open Loop Project
7.1.2.3.1.1 Setting Software Options for Build 1

1. Make sure the hardware is setup as shown in Figure 16. Do not supply any high-voltage power to the board yet.

2. powerSUITE settings: On the powerSUITE page, select under the Project Options section:
   - Open Loop for the build level
   - AC for the Output
   - Either SDFM or ADC for the sensing method depending on what is in the design (For this design, both SDFM and ADC sensing methods are present)
   - Enter output frequency as 60 Hz

   If this is an adapted solution, edit the setting under ADC Sensing Parameters, SDFM Sensing Parameters with the sensing resistors used in each case. Specify the switching frequency, the dead band, and the power rating. Save the page.

7.1.2.3.1.2 Building and Loading the Project

1. Right click on the project name and click Rebuild Project.
2. The project will build successfully.
3. In the Project Explorer, make sure the correct target configuration file is set as Active, as shown in Figure 20.
4. Click Run → Debug to launch a debugging session. A window can appear to select the CPU the debug needs to be performed on in case of dual CPU devices. In this case, select CPU1.

7.1.2.3.1.3 Setup Debug Environment Windows

1. To add the variables in the watch and expressions window, click View → Scripting Console to open the scripting console dialog box.
2. On the upper right corner of the console, click on open to browse to the setupdebugenv_build1.js script file inside the project folder.
3. The watch window will be populated with the appropriate variables needed to debug the system.
4. Click on the Continuous Refresh button on the watch window to enable continuous update of values from the controller.

   Figure 22 shows how the watch window will appear after these steps are taken.
5. The inverter current and voltage measurements can also be verified by viewing the data in the graph window. These values are logged in the inverterISR() routine.

6. Go to Tools → Graph → DualTime and click on Import and point to the graph1.GraphProp file inside the project folder.

7. The graph will populate in the properties window.

8. Alternatively, the user can enter the values as shown in Figure 23.

9. Click OK once the entries are verified.

10. Two graphs will appear in the CCS.

11. Click on Continuous Refresh on the graphs.

   A second set of graphs can be added by importing graph2.GraphProp file.

**Figure 22. Build Level 1 Expressions View**
7.1.2.3.1.4 Using Real-Time Emulation

Real-time emulation is a special emulation feature that allows windows within CCS to be updated while the MCU is running. This allows graphs and watch views to update, but also allows the user to change values in watch or memory windows, and see the effect of these changes in the system without halting the processor.

1. Enable real-time mode by hovering the mouse on the buttons on the horizontal toolbar and clicking the button.

2. A message box may appear.

3. If the message box appears, select Yes to enable debug events.

4. Clicking Yes sets bit 1 (DGM but) of status register 1 (ST1) to 0.

**NOTE:** The DGBM is the debug enable mask bit. When the DGBM bit is set to 0, the memory and register values are passed to the host processor for updating the debugging windows.
7.1.2.3.1.5 Running the Code

1. Run the project by clicking the green arrow button.
2. In the watch view, check if the guiVbus, guiI, guiIo, and guiVo variables are updating periodically.
3. Set the value of rlyConnect to 1, which will connect the relay, and the user will hear a clicking sound.
4. Set the clearInvTrip variable to 1.
5. EmPwm1Regs.TZFLG.all appears.
6. Set EPwm1Regs to zero, and the boardStatus will update to boardStatus_NoFault.
7. Set the invModIndex to 0.5.
8. With a resistance of 100 Ω connected at the output, first raise the input DC bus up slowly to 50 V. Observe the current and voltage waveform on the scope. AC current and voltage waveform should appear albeit at a low voltage. Now, slowly increase the DC bus to 380 V.
9. Observe the AC waveform on the oscilloscope for the voltage and current.
10. Observe the clean AC waveform (owing to the low frequency switching, a sharp pulse around the zero crossing is expected).
11. Check the frequency of the generated AC waveform.
12. Confirm that the frequency matches the value entered on the powerSUITE page.
13. Confirm the AC measurement is correct by viewing the gui_Vrms and gui_Irms values.
14. For the DC bus of 380 V, and a 100-Ω output with a 0.5 inverter modulation index, the output voltage will be close to guiVrms = 133, and the current will be guiIrms = 1.35 A for SDFM sensing; for ADC sensing, the measured current is going to be higher because the inductor current is measured instead of the output current.

NOTE: If there are inconsistencies in the measured valued and the actual values, confirm that the hardware and enter the correct values on the powerSUITE page for the scaling of voltages and currents.

Figure 24 shows the build level 1 expressions view with power measurement.
Figure 25 shows the graph window inside CCS that was set up previously (see Figure 23). The measured voltage and current AC waveform can be observed on these graphs.

Figure 25 shows the graph imported in the build level 1 through the graph1.graphprop file, displaying the measured per-unit voltage and current values.

If nothing is observed in the graph, put dlog1.status in the Expression window, and if it is set to 0, set it to 1. Also, if multiple AC cycle need to be observed, enter dlog1.prescalar to be greater than 1; for example, it can be set to be 5.

15. The AC voltage may be modulated by changing the modulation index through the watch window.
16. The check for this build is now completed.
17. Verify the following items on successful completion of the build.
   a. Inverter modulation scheme and generation of correct AC waveform.
   b. Sensing of voltages, currents, and scalings are correct.
   c. Interrupt generation and execution of the build 1 code in the inverter ISR.
18. To power down, set $invModIndex$ to zero.
19. Set $rlyConnect$ to zero.
20. Slowly decrease the DC bus voltage to 0 V.
21. The controller can now be halted, and the debug connection is terminated.

NOTE: In case CCS loses connection at any point, bring the system to a safe stop by bringing the input voltage to zero and then disconnecting the JTAG cable and reconnecting.
7.1.2.3.2 Build Level 2—Close Current Loop

In Build 1, the open loop operation of the inverter is verified. In this build, Build 2, the inner current loop is closed. For example, the inductor current is controlled using a current compensator $G_i$. Both DC bus and output voltage feed forward are applied to the output of this current compensator to generate the duty cycle of the inverter, as shown in Equation 12. The plant for the current compensator is simple to use, and a proportional integral (PI) controller may be used to tune the loop of the inner current.

$$\text{invDutyPU} = \frac{\text{invliRefInst} - \text{invliInst}}{\text{invVbusInst}} \times G_i + \text{invVolInst}$$

Equation 12

Figure 26 shows the build level 2 control diagram of the closed current loop.
7.1.2.3.2.1 Setting Software Options for Build 2

1. Make sure the hardware is set up as outlined in the previous sections (see Figure 16). Do not supply any high-voltage power yet to the board.

2. powerSUITE settings: On the powerSUITE page select under "Project Options" section:
   - "Closed Current Loop" for the build level
   - "DC" for the output
   - Either "SDFM" or "ADC" for sensing method depending on what is on the design (On this design, both SDFM and ADC sensing methods are present).
   Save the page.

3. Under "Control Loop Design", select Tuning → Current Loop, Comp Number → COMPI, Comp Style → DCL_Pi_C3, and click on the Compensation Designer icon.

7.1.2.3.2.2 Designing Current Loop Compensator

Compensation designer launches with the model of the current loop plant for the inverter, and parameters are specified on the powerSUITE page. Compensator values can be changed to ensure stable closed loop operation. Stability of the system when using the designed compensator must be verified by observing the gain and phase margins on the open loop transfer function plot in the compensation designer, as shown in Figure 27.

![Figure 27. Current Loop Design Using Compensation Designer](image-url)
1. Once satisfied with the compensation design, click on Save Comp. This option saves the compensator values into the project.

**NOTE:** If the project was not selected from the solution adapter, changes to the compensator will not be allowed. The user is not able to design their own select solution through the solution adapter.

2. Close the compensation designer.
3. Return to the powerSUITE page.

### 7.1.2.3.2.3 Building and Loading the Project and Setting up Debug

1. Right click on the project name, and click Rebuild Project.
2. The project will build successfully.
3. Click Run → Debug to launch a debugging session.
4. A window to select the CPU may appear.
5. A debug needs to be performed in case of dual CPU devices.
7. The project will load on the device, and CCS debug view will become active.
8. The code will halt at the start of the main routine.
9. To add variables in the watch and expressions window, click View → Scripting Console to open the scripting console dialog box.
10. On the upper right corner of the console, click open to browse the setupdebugenv_build2.js script file located inside the project folder.
11. The watch window will populate with the appropriate variables needed to debug the system.
12. Click on the Continuous Refresh button on the watch window to enable a continuous update of values from the controller. Figure 28 shows how the watch window will appear.

![Figure 28. Build Level 1 Expressions View](image)

13. As this is a DC check, the graph window is not used.
14. Enable real-time mode by hovering the mouse on the buttons on the horizontal toolbar, and click the **Enable Silicon Real-time Mode** button.

---

**Enable Silicon Real-time Mode (service critical interrupts when halted, allow debugger accesses while running).**

---
7.1.2.3.3 Running the Code

1. Run the project by clicking the button.
2. Clear the inverter trip by setting the clearlnvTrip variable to 1.
3. Set the rlyConnect variable to 1 to connect the relay.
4. Set a small current command of 0.02 for invliRef.
5. Slowly raise the DC bus.
6. Observe the invliInst rises slowly, and then regulates at the value set by invliRef.
7. For the 100-Ω output load, the inverter will begin regulating the current once the DC bus is raised about 50 V. Increasing the DC Bus further will not result in increase in the invliInst, which verifies closed loop operation.
8. Once the closed loop operation is verified, for example, invlireflnst closely matches invliRef, the DC bus must be raised to the operating voltage, such as 380 V.

NOTE: If the closed loop operation is not verified, the user must reduce the DC bus immediately, and verify Build 1 to see if all the voltage and current sensing parameters are correct. The user must also visit the compensation designer again to verify that the system has enough gain at DC.

9. After raising the DC bus to 380 V, the invliRef must be increased in steps of 0.02 pu to 0.08 pu, while continually monitoring closed loop operation (that is, with invliInst matched invliRef at every step change, one can monitor these on the oscilloscope as well to verify settling time, overshoot, and so on).
10. This design at 380-V DC input with 0.08-pu current invliRef set will correspond to approximately 1.3 Amps of current in case of SDFM monitored using a guiIi variable, which with a 100-Ω load, will equal 170 W of power.

NOTE: SFRA is integrated in the software of this build to verify the designed compensator provides enough gain and phase margin by measuring on hardware.

11. To run the SFRA, keep the project running and from the CFG page, click on the SFRA icon.
12. SFRA GUI will appear.
13. Select the options for the device on the GUI; for example, for TMS320F28377D, select floating point.
14. Click on setup connection.
15. On the pop-up window, uncheck the boot on connect option.
16. Select an appropriate COM port, and click OK.
17. Return to the SFRA GUI.
18. Click connect.
19. The SFRA GUI will connect to the device.
20. A SFRA sweep can now be started by clicking on Start Sweep.
21. The complete SFRA sweep will take a few minutes to complete.
22. Activity may be monitored by viewing the progress bar on the SFRA GUI, and also by checking the flashing of the blue LED light on the back of the control card that indicates UART activity.
   If these blue LEDs stop blinking, it indicates a loss of communication. Under this situation, close SFRA GUI, and restart the connection process. If the situation persists, bring the system to a safe stop by setting the invliRef to 0 and bringing the DC bus voltage down to 0. Terminate the debug session, followed by connecting and reconnecting the JTAG USB cable to reset the JTAG circuit and relaunch a debug session by following the steps outlined previously to rerun the SFRA.
23. Once complete, a graph will open a loop plot, as shown in Figure 29. This verifies that the designed compensator is stable.

![Software Frequency Response Analyzer](image)

**Figure 29. SFRA Run on Closed Current Loop**

The frequency response data is also saved in the project folder under an SFRA Data Folder, and is time stamped with the time of the SFRA run.

The measured gain and phase margin are better than the modeled values, indicating slight differences in modeled and measured response. In this case, the difference is of gain reduction which decreases the bandwidth, but improves the margins. However, depending on the estimate of the parameters of the power stage, the margins may shift either way and it is essential to measure the response to ensure robust operation.

For the voltage source inverter, TI recommends to keep the crossover of the inner current loop at greater than ten times the AC frequency, which is met by this compensator, and no changes are needed in the design. If an adapted solution is not met, the compensator must be changed to ensure the crossover of the current loop meets this requirement.

24. Click on the Compensation Designer from the CFG page.

25. Choose SFRA Data for the plant option on the GUI. This will use the measured plant information to design the compensator. This option must be used to fine tune the compensation.

---

**NOTE:** By default, the compensation designer will point to the latest SFRA run.

26. If a previous SFRA run plant information needs to be used, the user must select the `SFRAData.csv` file by browsing to it.

27. Click on Browse SFRA Data.

28. Close Compensation Designer to return to the cfg page.
Figure 30 shows the compensation designer with measured plant frequency response data.

Figure 30. Compensation Designer With Measured Plant Frequency Response Data

29. The current compensator design has been verified.
30. Set the `invlRef` to zero.
31. Reduce the DC bus to zero.
32. Disconnect the relay by setting `rlyConnect` to zero.
33. Fully halting the MCU when in real-time mode is a two step process.
   
   34. First, halt the processor by clicking on the toolbar, or by using `Target → Halt`.
   
   35. Take the MCU out of real-time mode by clicking on .
   
   36. Finally, reset the MCU by clicking on .
   
   37. Close the CCS debug session by clicking on `Terminate Debug Session`, or by using `Target → Terminate all`. 
7.1.2.3.4 **Build 3—Closed Voltage Loop With Inner Current Loop**

In this build, the outer voltage loop is closed with the inner current loop (designed in Section 7.1.2.3.2). Multiple resonant controllers compensate for the errors found in the fundamental harmonics, as shown in Figure 27. A lead lag compensator is added to improve the phase margin and is turned through the compensation designer. Figure 31 shows the build level 3 control diagram of the output voltage control with inner current loop.

![Diagram](image-url)

**Figure 31. Build Level 3 Control Diagram: Output Voltage Control With Inner Current Loop**
7.1.2.3.4.1 Setting Software Options for Build 3

1. Make sure the hardware is set up, as shown in Figure 16, and no power except for the bias is energized.
2. If an adapted solution, modified parameters must be entered as outlined in Section 7.1.2.3.1 for the custom design.
3. Under Project Options, select Closed Voltage and Current Loop.
4. Select AC for output.
5. The user must select sensing to be what is available for the design.
6. Under Control Loop Design:
   a. Select Tuning as Voltage Loop.
   b. Style will be present to Lead Lag.
   c. Parameters for the resonant controller must be specified under the Voltage Loop Resonant Controller section.
   d. Save the page by entering Ctrl+S.
   e. Click on the Compensation Designer button.

7.1.2.3.4.2 Designing Voltage Loop Compensator

1. The compensation designer launches with the model of the voltage loop plant for the inverter with the current loop as shown in Figure 32.
2. Note in Build Level 2, the measured gain of the plant was lower than the modeled, hence the margins in this build are lower when using the modeled plant. With the measured response these margins will be larger and hence more stable.

NOTE: The compensation designer implements the PR and harmonic resonant controller, which are entered on the powerSUITE CFG page. This allows tuning of the lead lag compensator to improve the phase margin. To tune the resonant controllers, modify the parameters on the powerSUITE page, and re-invoke the compensation designer.

A lead-lag compensator can be designed using the compensation designed to improve upon the gain and phase margins in the design.
1. Once satisfied with the compensator design, click **Save Comp**.
2. The compensator values are now saved into the project.
3. Close the compensation designer.
4. Return to the powerSUITE page.
5. Save by typing in **Ctrl+S**.

7.1.2.3.4.3 **Building and Loading the Project, and Setting Up Debug**

1. Right-click on the project name.
2. Click **Rebuild Project**.
3. The project will build successfully.
4. Click **Run → Debug**.
5. A debugging session is launched.
6. A window may appear to select the CPU. Perform a debug for dual CPU devices.
7. Select CPU1.
8. The project loads on the device, and the CCS debug view is active.
9. The code halts at the start of the main routine.
10. To add the variables in the watch and expressions window, click **View → Scripting Console** to open the scripting console dialog box.
11. On the upper right corner, click open to browse the **setupdebugenv_build3.js** script file, located inside the project folder.
12. The watch window populates with the appropriate variables needed to debug the system.
13. Click on the **Continuous Refresh** button on the watch window to enable a continuous update if values from the controller.

Figure 32. Voltage Loop Lag Compensation Tuning Using Compensation Designer
14. Figure 33 shows how the watch window will appear.

![Figure 33. Build Level 1 Expressions View](image)

15. Enable real-time mode by hovering the mouse on the buttons on the horizontal toolbar, and clicking the Enable Silicon Real-time Mode (service critical interrupts when halted, allow debugger accesses while running) button.

### 7.1.2.3.4.4 Running the Code

1. Run the project by clicking on 
2. Clear the inverter trip by setting the `clearInvTrip` variable to 1.
3. Set `rlyConnect` to 1 to connect the relay.
4. Set a small current command of 0.02 for `invVoRef`.
5. Slowly raise the DC bus.
6. Observe that the `invVoRef` will appear square in shape to begin with, and as the DC bus is raised, it will take a clean AC waveform shape. Raise the DC bus slowly up to 50 V.
7. If the clean AC waveform shape does not appear, revisit the compensation design for the voltage loop.
   A quick verification of the closed loop operation can be done by increasing the DC Bus further, but the output voltage AC will regulate at a fixed voltage set at 0.02 by `invVoRef`. Because this is an AC Build, the expressions window values will constantly change and hence cannot be used to infer on a closed loop operation.
8. Once the closed loop operation is verified, raise the DC bus to the operating voltage to approximately 380 V.
9. Increase the `invVoRef` to 0.25 gradually in steps of 0.05.
10. Observe a regulated voltage at the output, which will be similar to as shown in Figure 34.
Note in Figure 34 the output is being regulated at full power for this design, and this is not be the exact power level one will reach following the previous steps. Figure 34 is shown as an illustration of full power operation which is at maximum power level.

VAC = 110 V\textsubscript{RMS}, P\textsubscript{OUT} = 589 W, THD = 0.36\%, and efficiency = 96.9\% (blue is voltage, red is current).

Figure 34. Output Voltage Regulated With Linear Load in Build 3

11. The voltage compensator design is verified.
12. Set the \texttt{invVoRef} to zero.
13. Reduce the DC bus to zero.
14. Set \texttt{rylConnect} to zero to disconnect the relay.
15. Fully halting the MCU when in real-time mode is a two-step process.

16. Halt the processor and clicking the halt button \textbullet{} on the toolbar, or by using \texttt{Target → Halt}.

17. Take the MCU out of real-time mode by clicking the clock button \textbullet{}.

18. Reset the MCU by clicking \textbullet{}.

19. Close the CCS debug session by clicking \texttt{Terminate Debug Session}, or by using \texttt{Target → Terminate all}.

20. The steps above may be repeated by connecting a non-linear load to the output of the inverter.

7.1.2.3.5 \textit{Build 3 Demo Mode}

In this build, once the control loops have been verified, start and stop the inverter with variables in the expressions window. Demo mode is also used to run the design out of the box if the exact same design is available. If any modifications have been done, the control loops need to be re-verified as described in Section 7.1.2.3.1, Section 7.1.2.3.2, and Section 7.1.2.3.4. Open the project inside CCS, as outlined in Section 7.1.2.1. Make the following changes and verify the following settings.
7.1.2.3.5.1 Setting Software Options for Build 3 Demo Mode

1. Set up the hardware as outlined in Figure 16.
2. On the powerSUITE page, select Closed Voltage and Current Loop under Project Options.
3. Select AC for output.
4. Select SDFM for sensing if available on the design.
5. Enter 60 Hz for frequency for the AC waveform. This will be the frequency of the inverter output.
6. Under Inverter Power Stage Parameters, enter 110 $V_{\text{RMS}}$ for the output voltage. This will be the value that the AC output will regulate to.
7. Type Ctrl+S to save the page.

7.1.2.3.5.2 Building and Loading the Project and Setting up Debug

1. Right-click on the project name.
2. Select Rebuild Project.
3. The project will build successfully.
4. Click Run → Debug, and the debugging session will launch.
5. Select CPU1 if a window appears asking to select a CPU. A debug must be performed in the cause of dual CPU devices.
6. The project will load on the device, and CCS debug view becomes active.
7. The code halts at the start of the main routine.
8. Click View → Scripting Console to add variables to the watch and expressions window.
9. The scripting console dialog box opens.
10. Click open in the upper right corner of the console to browse the setupdebugenv_demo.js script file located inside the project folder.
11. The watch window populates with the appropriate variables required to debug the system.
12. Click the Continuous Refresh button on the watch window to enable continuous update of values from the controller.
13. Figure 35 shows how the watch window will appear.

![Figure 35. Build Level 3 Demo Mode Expressions View](image)

14. Enable real-time mode by hovering your mouse on the button on the horizontal toolbar, and click the Enable Silicon Real-time Mode (service critical interrupts when halted, allow debugger accesses while running) button.
7.1.2.3.5.3 Running the Code

1. Click the green arrow button to run the project.
2. Set $guilnvStart$ to 1 to start the inverter (boardStatus will change to checkDCBus).
3. Now slowly raise the DC Bus at the input to be 10% higher than the peak value of the output voltage desired. For example, if 110 V$_{\text{RMS}}$ was specified under the Inverter Power Stage Parameters in the previous section, the peak voltage will be $110 \times 1.414 = 155.54$ and the DC Bus voltage must be set to be 10% higher than this, which is $155.54 \times 1.1 = 171$ V.
4. The inverter starts as soon as the DC bus voltage is present at a greater level than 10% of the AC maximum.
5. Observe the controlled AC voltage waveform on the output.

**NOTE:** The frequency and the amplitude of the AC voltage is determined by the values on the powerSUITE page of the solution.

6. If any changes are required, stop the inverter.
7. Set $guiInvStop$ to 1.
8. Reduce the input DC bus to zero V.
9. Halt the processor.
10. Disable real-time mode.
11. Return to the powerSUITE page.
12. Make the required changes to the page.
13. Save.
15. Reload and run the project.
16. Set $guiInvStart$ to 1 to start the inverter operation.
17. Raise the DC bus to be greater than the maximum voltage of the AC nominal.
18. The inverter now operates with the new setting condition.
19. Never exceed the VA rating of the inverter at any operating point.

**NOTE:** Fully halting the MCU in real-time mode is a two-step process.

20. Click the halt button on the toolbar , or use Target $\rightarrow$ Halt to halt the processor.
21. Click on the clock button to take the MCU out of real-time mode.
22. Rest the MCU by clicking on.
23. Click the Terminate Debug Session button , or use Target $\rightarrow$ Terminate all to close the CCS debug session.
7.2 Testing and Results

7.2.1 Test Results With Linear Loads

Figure 36 shows that the tests for the linear load are carried out by inserting a resistance at the output of the inverter.

![Test Setup for Linear Load](image)

Figure 36. Test Setup for Linear Load

7.2.1.1 Power Stage Efficiency With Linear Load (Same for SDFM or ADC)

Figure 37 shows the efficiency of operating this reference design across power range and with 110 V\( \text{RMS} \) or 220 V\( \text{RMS} \) of output.

![Power Stage Efficiency at 110 V\( \text{RMS} \) and 220 V\( \text{RMS} \) of Output](image)

Figure 37. Power Stage Efficiency at 110 V\( \text{RMS} \) and 220 V\( \text{RMS} \) of Output
7.2.1.2 Steady State Waveform

Figure 38 and Figure 39 show the current and voltage waveform under a steady state condition at 100 \( V_{RMS} \) of output and 220 \( V_{RMS} \) of output, respectively.

\( V_{AC} = 110 \, V_{RMS} \), \( P_{OUT} = 589 \, W \), THD = 0.36\%, and efficiency = 96.9\% (blue is voltage, red is current).

![Figure 38. Steady State Waveforms With the Linear Load Operating at 110 \( V_{RMS} \)](image-url)

\( V_{AC} = 220 \, V_{RMS} \), \( P_{OUT} = 552 \, W \), THD = 0.35\%, and efficiency = 98\% (blue is voltage, red is current).

![Figure 39. Steady State Waveforms With the Linear Load Operating at 220 \( V_{RMS} \)](image-url)
7.2.1.3 Transient Waveform With Step Change in Load

Figure 40 shows the voltage waveform when a step change in load is applied, illustrating good output voltage regulation (blue is voltage, red is current).

Figure 40. Voltage Waveform With Transient Change in Load

7.2.1.4 Total Harmonic Distortion With Linear Loads Using SDFM-Based Sensing

Figure 41 shows total harmonic distortion with the linear load at the output, and the output voltage controlled at 110 V\text{RMS} and 220 V\text{RMS} at different power levels with SDF sensing used for control.

Figure 41. Total Harmonic Distortion With Linear Loads Using SDFM Sensing
7.2.1.5 Total Harmonic Distortion Using ADC-Based Sensing

Figure 42 shows total harmonic distortion with the linear load at the output, and the output controlled at 110 \( V_{\text{RMS}} \) and 220 \( V_{\text{RMS}} \) at different power levels with ADC sensing used for control.

![Figure 42. Total Harmonic Distortion Using ADC-Based Sensing](image)

7.2.1.6 Test Data Table With SDFM-Based Sensing

Table 5 and Table 6 shows the complete test data at 110 \( V_{\text{RMS}} \) of output voltage and 220 \( V_{\text{RMS}} \) of output voltage, respectively.

### Table 5. Test Data at 110-\( V_{\text{RMS}} \) \( V_{\text{OUT}} \) and SDFM-Based Sensing

<table>
<thead>
<tr>
<th>( V_{\text{IN}} )</th>
<th>( I_{\text{IN}} )</th>
<th>( V_{\text{OUT}} )</th>
<th>( I_{\text{OUT}} )</th>
<th>( P_{\text{IN}} )</th>
<th>( P_{\text{OUT}} )</th>
<th>THD( v )</th>
<th>EFFICIENCY</th>
</tr>
</thead>
<tbody>
<tr>
<td>382.8</td>
<td>0.08</td>
<td>109.93</td>
<td>0.2604</td>
<td>30.624</td>
<td>28.628</td>
<td>0.22</td>
<td>0.934822362</td>
</tr>
<tr>
<td>382.7</td>
<td>0.166</td>
<td>109.89</td>
<td>0.5563</td>
<td>63.5282</td>
<td>61.135</td>
<td>0.23</td>
<td>0.962328541</td>
</tr>
<tr>
<td>382.6</td>
<td>0.221</td>
<td>109.83</td>
<td>0.7439</td>
<td>84.5546</td>
<td>81.714</td>
<td>0.21</td>
<td>0.966405139</td>
</tr>
<tr>
<td>382.8</td>
<td>0.328</td>
<td>109.75</td>
<td>1.106</td>
<td>125.5584</td>
<td>121.41</td>
<td>0.22</td>
<td>0.966960395</td>
</tr>
<tr>
<td>382.6</td>
<td>0.654</td>
<td>109.47</td>
<td>2.2112</td>
<td>250.2204</td>
<td>242.08</td>
<td>0.28</td>
<td>0.967467081</td>
</tr>
<tr>
<td>382.8</td>
<td>0.987</td>
<td>109.49</td>
<td>3.3156</td>
<td>377.8236</td>
<td>363.12</td>
<td>0.35</td>
<td>0.961083426</td>
</tr>
<tr>
<td>382.8</td>
<td>1.301</td>
<td>108.86</td>
<td>4.3628</td>
<td>498.0228</td>
<td>475.23</td>
<td>0.4</td>
<td>0.954233421</td>
</tr>
</tbody>
</table>

### Table 6. Test Data at 220-\( V_{\text{RMS}} \) \( V_{\text{OUT}} \) and SDFM-Based Sensing

<table>
<thead>
<tr>
<th>( V_{\text{IN}} )</th>
<th>( I_{\text{IN}} )</th>
<th>( V_{\text{OUT}} )</th>
<th>( I_{\text{OUT}} )</th>
<th>( P_{\text{IN}} )</th>
<th>( P_{\text{OUT}} )</th>
<th>THD( v )</th>
<th>EFFICIENCY</th>
</tr>
</thead>
<tbody>
<tr>
<td>382.6</td>
<td>0.076</td>
<td>218.74</td>
<td>0.1209</td>
<td>29.0776</td>
<td>24.976</td>
<td>0.25</td>
<td>0.858942966</td>
</tr>
<tr>
<td>382.8</td>
<td>0.138</td>
<td>218.71</td>
<td>0.2246</td>
<td>52.8264</td>
<td>48.646</td>
<td>0.25</td>
<td>0.920865325</td>
</tr>
<tr>
<td>382.8</td>
<td>0.306</td>
<td>218.61</td>
<td>0.5178</td>
<td>117.1368</td>
<td>113.21</td>
<td>0.24</td>
<td>0.966476803</td>
</tr>
<tr>
<td>382.7</td>
<td>0.647</td>
<td>218.5</td>
<td>1.1066</td>
<td>247.6069</td>
<td>241.82</td>
<td>0.25</td>
<td>0.97662868</td>
</tr>
<tr>
<td>382.8</td>
<td>0.857</td>
<td>218.38</td>
<td>1.4695</td>
<td>328.0596</td>
<td>320.99</td>
<td>0.25</td>
<td>0.978450257</td>
</tr>
<tr>
<td>382.8</td>
<td>1.28</td>
<td>218.16</td>
<td>2.2003</td>
<td>489.984</td>
<td>480.03</td>
<td>0.25</td>
<td>0.979685051</td>
</tr>
<tr>
<td>382.8</td>
<td>1.558</td>
<td>219.44</td>
<td>2.6615</td>
<td>596.4024</td>
<td>584.12</td>
<td>0.26</td>
<td>0.979405851</td>
</tr>
</tbody>
</table>
7.2.1.7 Test Data Table With ADC

Table 7 and Table 8 show complete test data at 110 $V_{\text{RMS}}$ of output voltage and 220 $V_{\text{RMS}}$ of output voltage, respectively.

Table 7. Test Data at 110-$V_{\text{RMS}}$ $V_{\text{OUT}}$ and ADC-Based Sensing

<table>
<thead>
<tr>
<th>$V_{\text{IN}}$</th>
<th>$I_{\text{IN}}$</th>
<th>$V_{\text{OUT}}$</th>
<th>$I_{\text{OUT}}$</th>
<th>$P_{\text{IN}}$</th>
<th>$P_{\text{OUT}}$</th>
<th>THDv</th>
<th>EFFICIENCY</th>
</tr>
</thead>
<tbody>
<tr>
<td>382.8</td>
<td>0.08</td>
<td>109.93</td>
<td>0.2604</td>
<td>30.624</td>
<td>28.628</td>
<td>1.5</td>
<td>0.934822362</td>
</tr>
<tr>
<td>382.8</td>
<td>0.1705</td>
<td>111.2</td>
<td>0.563</td>
<td>65.2674</td>
<td>62.621</td>
<td>1.63</td>
<td>0.959452958</td>
</tr>
<tr>
<td>382.6</td>
<td>0.226</td>
<td>111.13</td>
<td>0.7528</td>
<td>86.4676</td>
<td>83.669</td>
<td>1.59</td>
<td>0.96763412</td>
</tr>
<tr>
<td>382.8</td>
<td>0.335</td>
<td>111.04</td>
<td>1.1195</td>
<td>128.238</td>
<td>124.3</td>
<td>1.44</td>
<td>0.969291474</td>
</tr>
<tr>
<td>382.6</td>
<td>0.67</td>
<td>111.8</td>
<td>2.2393</td>
<td>256.342</td>
<td>248.15</td>
<td>1.45</td>
<td>0.968042693</td>
</tr>
<tr>
<td>382.8</td>
<td>1.007</td>
<td>110.69</td>
<td>3.3543</td>
<td>385.4796</td>
<td>371.38</td>
<td>1.65</td>
<td>0.963423227</td>
</tr>
<tr>
<td>382.8</td>
<td>1.34</td>
<td>110.64</td>
<td>4.4367</td>
<td>512.952</td>
<td>490.96</td>
<td>1.94</td>
<td>0.957126593</td>
</tr>
</tbody>
</table>

Table 8. Test Data at 220-$V_{\text{RMS}}$ $V_{\text{OUT}}$ and ADC-Based Sensing

<table>
<thead>
<tr>
<th>$V_{\text{IN}}$</th>
<th>$I_{\text{IN}}$</th>
<th>$V_{\text{OUT}}$</th>
<th>$I_{\text{OUT}}$</th>
<th>$P_{\text{IN}}$</th>
<th>$P_{\text{OUT}}$</th>
<th>THDv</th>
<th>EFFICIENCY</th>
</tr>
</thead>
<tbody>
<tr>
<td>382.8</td>
<td>0.079</td>
<td>222.46</td>
<td>0.1229</td>
<td>30.2254</td>
<td>25.832</td>
<td>0.55</td>
<td>0.854645431</td>
</tr>
<tr>
<td>382.8</td>
<td>0.143</td>
<td>222.42</td>
<td>0.2286</td>
<td>54.7404</td>
<td>50.339</td>
<td>0.56</td>
<td>0.919595034</td>
</tr>
<tr>
<td>382.8</td>
<td>0.318</td>
<td>222.35</td>
<td>0.5268</td>
<td>121.7304</td>
<td>117.14</td>
<td>0.58</td>
<td>0.962290439</td>
</tr>
<tr>
<td>382.8</td>
<td>0.67</td>
<td>222.27</td>
<td>1.1262</td>
<td>256.476</td>
<td>250.38</td>
<td>0.6</td>
<td>0.976231694</td>
</tr>
<tr>
<td>382.8</td>
<td>0.886</td>
<td>222.13</td>
<td>1.4944</td>
<td>339.1608</td>
<td>332.04</td>
<td>0.6</td>
<td>0.979004649</td>
</tr>
<tr>
<td>382.8</td>
<td>1.323</td>
<td>221.9</td>
<td>2.237</td>
<td>506.4444</td>
<td>496.42</td>
<td>0.6</td>
<td>0.980206317</td>
</tr>
<tr>
<td>382.8</td>
<td>1.767</td>
<td>221.7</td>
<td>2.9867</td>
<td>676.4076</td>
<td>662.19</td>
<td>0.7</td>
<td>0.978980721</td>
</tr>
</tbody>
</table>

7.2.2 Test Results With Non-Linear Loads

Figure 43 shows the test setup for the measurement of performance under non-linear loads.

![Figure 43. Non-Linear Load Test Setup](image-url)
7.2.2.1 Waveform With SDFM

Figure 44 shows the output voltage and the current of the inverter when a non-linear load featuring a rectifier and a 330-µF capacitor and the resistive load is connected at the output and the SDFM is used for control.

\[ V_{AC} = 110 \text{ V}_{\text{RMS}}, \quad P_{\text{OUT}} = 312 \text{ W}, \quad \text{THD} = 2.9\%, \quad \text{efficiency} = 94\%, \quad \text{and PF of load} = 0.64\% \] (blue is voltage, red is current).

Figure 44. Current and Voltage Waveform Under a Non-Linear Load With SDFM Sensing at 110 V\(_{\text{RMS}}\)

Figure 45 shows the output voltage and current of the inverter when a non-linear load featuring a rectifier and a 300-µF capacitor and the resistive load is connected at the output, and the ADC is used for control.

\[ V_{AC} = 220 \text{ V}_{\text{RMS}}, \quad P_{\text{OUT}} = 575 \text{ W}, \quad \text{THD} = 2.6\%, \quad \text{efficiency} = 94.5\%, \quad \text{and PF of load} = 0.64 \] (blue is voltage, red is current).

Figure 45. Current and Voltage Waveform Under a Non-Linear Load With SDFM Sensing at 220 V\(_{\text{RMS}}\)
7.2.2.2 Waveform With ADC

Figure 46 shows the output voltage and current of the inverter when a non-linear load featuring a rectifier and a 330-µF capacitor and the resistive load is connected at the output, and the ADC is used for control at 110 V_{RMS} of output.

\[ V_{AC} = 100 \text{ V}_{RMS}, \ P_{OUT} = 209 \text{ W}, \ \text{THD} = 3.856\%, \ \text{efficiency} = 94.7\%, \ \text{and PF of load} = 0.64 \] (blue is voltage, red is current).

Figure 46. Current and Voltage Waveform Under a Non-Linear Load With ADC Sensing at 110 V_{RMS}

Figure 47 shows the output voltage and current of the inverter when a non-linear load featuring a rectifier and a 330-µF capacitor and the resistive load is connected at the output and ADC is used for control at 220 V_{RMS} of output.

\[ V_{AC} = 220 \text{ V}_{RMS}, \ P_{OUT} = 390 \text{ W}, \ \text{THD} = 3.1\%, \ \text{efficiency} = 95.9\%, \ \text{and PF of load} = 0.64 \] (blue is voltage, red is current).

Figure 47. Current and Voltage Waveform Under a Non-Linear Load With ADC Sensing at 220 V_{RMS}
8 Design Files

For schematics, bill of materials (BOM), altium project, and Gerber files, see the design files at http://www.ti.com/tool/TIDM-HV-1PH-DCAC or under the DigitalPower SDK package at C2000Ware_DigitalPower_SDK_<version>/solutions/tidm_hv_1ph_dcac.

9 Software Files

To download the software files for this reference design, see the link at http://www.ti.com/tool/C2000WARE-DIGITALPOWER-SDK. This reference design can be found at http://www.ti.com/tool/TIDM-HV-1PH-DCAC.

10 Related Documentation


4. Texas Instruments, TMS320F2837xD Dual-Core Delfino™ Microcontrollers Data Sheet

5. Texas Instruments, TMS320F28004x Piccolo™ Microcontrollers Data Sheet

10.1 Trademarks

C2000, E2E, powerSUITE, Code Composer Studio, Delfino are trademarks of Texas Instruments. Excel is a registered trademark of Microsoft Corporation. All other trademarks are the property of their respective owners.

11 About the Author

MANISH BHARDWAJ is a systems application engineer with the C2000 Microcontrollers System Solutions Group at Texas Instruments, where he is responsible for developing reference design solutions for digital power, motor control and solar power applications. Before joining TI in 2009, Manish received his masters of science in electrical and computer engineering from Georgia Institute of Technology, Atlanta and Bachelor of Engineering from Netaji Subhash Institute of Technology, University of Delhi, India.
**Revision History**

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from B Revision (April 2017) to C Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Updated formatting to fit current design guide template .........................................................</td>
<td>1</td>
</tr>
<tr>
<td>• Correct part number from TMS320F280049M to TMS320F280049M in Resources .................................</td>
<td>1</td>
</tr>
<tr>
<td>• Added C2000Ware DigitalPower SDK to Resources .................................................................</td>
<td>1</td>
</tr>
<tr>
<td>• Added “TMS320F28377D and TMS320F280049M” to Features .......................................................</td>
<td>1</td>
</tr>
<tr>
<td>• Changed location of Excel sheet to  sdk_install_path_&lt;version&gt;/solutions/tidm_hv_1ph_dcac/hardware/baseboard/calculation.xlsx</td>
<td>5</td>
</tr>
<tr>
<td>• Updated the equation featured in Figure 4: AC Output Voltage Differential Sensing Using Resistor Divider and Op Amp ..........................</td>
<td>6</td>
</tr>
<tr>
<td>• Added note in Section 3.1.2: Firmware: powerSUITE and Incremental Build Software ..................</td>
<td>17</td>
</tr>
<tr>
<td>• Changed Step 5 in Section 3.1.2.1: Opening the Project Inside Code Composer Studio™ ..................</td>
<td>17</td>
</tr>
<tr>
<td>• Added guilo to Step 2 in Section 3.1.2.3.1.5: Running the Code ..................................................</td>
<td>25</td>
</tr>
<tr>
<td>• Changed the destination for the Compensation Designer icon in Step 3 of Section 3.1.2.3.2.1: Setting Software Options for Build 2 ...............................</td>
<td>28</td>
</tr>
<tr>
<td>• Changed image of Figure 30: Compensation Designer With Measured Plant Frequency Response Data</td>
<td>32</td>
</tr>
<tr>
<td>• Changed location of DigitalPower SDK package in Section 4: Design Files ..................................</td>
<td>47</td>
</tr>
<tr>
<td>• Changed the link to the software files .........................................................................................</td>
<td>47</td>
</tr>
<tr>
<td>• Added the TMS320F28004x Piccolo™ Microcontrollers Data Sheet to Section 6: Related Documentation</td>
<td>47</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Changes from A Revision (September 2016) to B Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Deleted third paragraph in Section 3.2: Voltage and Current Sensing ......................................</td>
<td>5</td>
</tr>
<tr>
<td>• Changed Figure 13: Control Diagram for Voltage Source Inverter ..............................................</td>
<td>11</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Changes from Original (November 2015) to A Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Changed output voltage in Table 1: Key System Specifications to “110 Vrms or 200 Vrms” ..........</td>
<td>3</td>
</tr>
<tr>
<td>• Added efficiency for 110 Vrms in Table 1: Key System Specifications ........................................</td>
<td>3</td>
</tr>
<tr>
<td>• Deleted “These can also be modified from the powerSUITE page for an adapted solution.” from Section 3.2: Voltage and Current Sensing ...............................................</td>
<td>5</td>
</tr>
<tr>
<td>• Added introduction to link in Section 3.4: Inductor Design .......................................................</td>
<td>12</td>
</tr>
<tr>
<td>• Added TIEVM-HV-1PH-DCAC note in Section 4: Getting Started With Hardware ..............................</td>
<td>13</td>
</tr>
<tr>
<td>• Added L2N slot in Step 2 in Section 4.1: Base Board Settings ....................................................</td>
<td>13</td>
</tr>
<tr>
<td>• Changed control card input from H5 to J15-J16 in Step 4 in Section 4.1: Base Board Settings .........</td>
<td>13</td>
</tr>
<tr>
<td>• Changed jumper insert spot from JP2 to J10 in Step 5 in Section 4.1: Base Board Settings ............</td>
<td>13</td>
</tr>
<tr>
<td>• Deleted flipping the switch S1 step .................................................................................................</td>
<td>13</td>
</tr>
<tr>
<td>• Added &quot;Insert a jumper at J4 if not already populated.&quot; to Step 7 in Section 4.1: Base Board Settings</td>
<td>13</td>
</tr>
<tr>
<td>• Changed DC source connection from CON1 to J17 in Step 9 in Section 4.1: Base Board Settings ....</td>
<td>13</td>
</tr>
<tr>
<td>• Changed resistive load value from 200 Ω to 100 Ω in Step 10 in Section 4.1: Base Board Settings ........................</td>
<td>13</td>
</tr>
<tr>
<td>• Changed connector name from CON1 to J17 in Table 4: Key Connectors and Their Function ...........</td>
<td>15</td>
</tr>
<tr>
<td>• Changed connector name from S1 to J4 in Table 4: Key Connectors and Their Function ..................</td>
<td>15</td>
</tr>
<tr>
<td>• Changed function from “Switch to connect and disconnect the DC bias of the board” to “Can be used to disconnect bias power” in Table 4: Key Connectors and Their Function ...............................</td>
<td>15</td>
</tr>
<tr>
<td>• Changed connector name from H5 to J15-J16 in Table 4: Key Connectors and Their Function ..........</td>
<td>15</td>
</tr>
<tr>
<td>• Changed connector name from JP2 to J10 in Table 4: Key Connectors and Their Function ..............</td>
<td>15</td>
</tr>
<tr>
<td>• Added Section 4.3: Tips to Connect JTAG USB Cable .....................................................................</td>
<td>16</td>
</tr>
<tr>
<td>• Changed Step 14 in Section 5.3.1: Build Level 1, Open Loop .......................................................</td>
<td>25</td>
</tr>
<tr>
<td>• Added paragraph before Figure 25: Build Level 1 Graph.1.GraphProp File Showing Measured Per-Unit Voltage and Current Values .........................................................</td>
<td>26</td>
</tr>
<tr>
<td>• Added ending ordered list to previous ordered list in Section 5.3.1: Build Level 1, Open Loop ........</td>
<td>26</td>
</tr>
</tbody>
</table>
Revision History

- Added note at the end of Section 5.3.1: Build Level 1, Open Loop .......................................................... 26
- Added Equation 12 ................................................................................................................................. 27
- Added setting software options for Build 2 to Section 5.3.2: BUILD Level 2, Close Current Loop .................. 28
- Changed from invliRef to inviliInst in Step 6 in Section 5.3.2: BUILD Level 2, Close Current Loop .................. 30
- Added "Increasing the DC Bus further will not result in increase in the inviliInst, which verifies closed loop operation." to Step 7 in Section 5.3.2: BUILD Level 2, Close Current Loop .................................................................................. 30
- Added "at 380V DC input with 0.08-pu current inviRef set" and "in case of SDFM monitored using guiIi variable" to Step 2 in Section 5.3.2: BUILD Level 2, Close Current Loop .................................................................................. 30
- Added paragraph to Step 14 in Section 5.3.2: BUILD Level 2, Close Current Loop .................................................. 30
- Deleted "By default, the compensation designer will point to the latest SFRA run," from note ......................... 31
- Deleted "Inst" from invliRefInst ............................................................................................................. 32
- Changed Step 2 of Designing Voltage Loop Compensator ........................................................................ 34
- Added "Raise the DC Bus slowly up to 50 V. " to Step 6 in Running the Code ................................................. 36
- Added paragraph to Step 6 in Running the Code ....................................................................................... 36
- Changed VAC from 100 V_{RMS} to 110 V_{RMS} ........................................................................................ 37
- Changed Step 3 of Running the Code ....................................................................................................... 39
IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated ("TI") technical, application or other design advice, services or information, including, but not limited to, reference designs and materials relating to evaluation modules, (collectively, "TI Resources") are intended to assist designers who are developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you (individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of this Notice.

TI's provision of TI Resources does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections, enhancements, improvements and other changes to its TI Resources.

You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications (and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any testing other than that specifically described in the published documentation for a particular TI Resource.

You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT. AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED "AS IS" AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-compliance with the terms and provisions of this Notice.

This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services. These include, without limitation, TI's standard terms for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm), evaluation modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated